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Usb Lisans Sistemi SözleĢmesi 
 

 

Espor Dijital ürünleri programla birlikte verilen USB kilit ile 
birlikte kullanılabilir. Program yalnızca USB kilit bilgisayara takılı 
olduğunda çalışacak, aksi durumda çalışmayacaktır. Kullanıcı 
programı istediği kadar bilgisayara kurabilir. Ancak usb kilit hangi 
bilgisayarda takılı ise o çalışır, diğerleri çalışmaz. 

 

Lisanslama USB kilit ile yapılmaktadır. USB kilidin her tütlü 
sorumluluğu alıcıya aittir. USB kilidin kaybolması durumunda Espor 

Dijital Firmasının bir sorumluluğu yoktur. Yerine yenisi verilmez. 

Alıcının her yeni USB kilit talebi, yeniden lisans bedeli ödemesini 

gerektirir. 

 

USB kilidin kırılması durumunda alıcı, kırılan USB kilidini 
Espor Dijital Firmasına göndermek şartı ile USB kilit maliyetini 
ödeyerek yeni bir kilit alabilir   

 

Alıcı Espor Dijital ürünü satın aldığında bu sözleşmeyi kabul 
etmiş sayılır. 
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Wındows Wısta Sistem Ayarları 
 

Başlat + Ayarlar + Denetim Masası yolu ile 
denetim masasını açın. 
 

 

“Kullanıcı Hesapları” nı bulup çift tıklayarak açınız.  

 

 

“Kullanıcı Hesabı Denetimi Aç veya Kapat” tıklayınız. 

“Devam Edeyimmi” sorusuna ok diyerek devam edin. 

Son ve en önemli adımda burada görülen çek i 

kaldırın ve “Tamam” butonuna tıklayınız. 

Bilgisayarınız kapatılıp açılacaktır.  

Wındows 7 Sistem Ayarları 
Başlat +  Denetim Masası yolu ile denetim 
masasını açın. 
 

 

“Kullanıcı Hesapları” nın üzerine tıklayınız. Bunu gelen 

ekranda bir kez daha yapınız. 

“Kullanıcı Hesabı Denetimi ayarlarını değiştir” i tıklayınız.  

Sürgüyü En Alta Çekerek gerekli ayarı yapınız. 

  



 9 

Hakkında 

 
eAnalyze Futbol’ u tercih ettiğiniz için teĢekkürler. 
 
Dünyanın her yerindeki futbol antrenörleri için piyasadaki en 
gelişmiş Müsabaka Analiz yazılımı satın aldınız. Sizin ve 
ekibinizin, en iyi avantaj elde edebildiği eAnalyze yazılımını 
geliştirmekten memnuniyet duyuyoruz. 
 
Başarılı bir çalıştırıcı olmak için analiz gereklidir ve üretilen 
bilgiler spor için kıymetlidir. Bu yüzden teknolojinin özellikle 
sizin için geliştirilmiş olması gerekir. İşte eSpor ürünlerini 
benzersiz yapanda budur. eAnalyze ™ ve eAssist ™ tüm 
antrenörler için özel teknoloji sağlamak üzere tasarlanmıştır. 

eAnalyze™ video üzerinden yapılan analiz ile bireysel ve 
takım faaliyetleri, oyun ve oyuncu verimlilik oranları ve oyun 
istatistikleri, özeleştirilmiş raporlar sağlar. En önemlisi de 
istenen her istatistiğe ait görüntüye ulaşılabilmesidir. Bu aynı 
zamanda oyuncuların eğitimi içinde çok önemli bir materyaldir. 

eAssist™ antrenörler için adeta bir sanal yardımcıdır. 
Antrenman ve taktik planların animasyonları ile birlikte 
geliştirilmesini sağlar. Ayrıca oyuncu kartları müsabaka bilgileri 
gibi bir çok detayında kaydedilebilmesi için idealdir. 

Futboldan başka Basketbol, Voleybol, Hentbol, USA Futbol, 
Buz Hokeyi, Lacrosse, Tenis gibi birçok branşta özel 
çözümlerimiz bulunmaktadır. 
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eAnaliz Üzerine 
 

Futbol için gerçek performans analizi. 

eAnalyze™ video analiz yazılımı antrenörlere oyun 
performansını değiştiren teknolojiyi sağlar. eAnalyze™ ile 
videoları parçalayıp birleştirmek, takım yada oyuncu düzeyinde 
istatistikler tutmak, her istatistiğe ait görüntülere ulaşmak, 
özelleştirilmiş raporlar almak son derece kolaydır. 

eAnalyze™’ in antrenörlere sağladığı yararlardan bazıları; 

 oyun analizi için dört farklı kolay yol, 
 İleri İstatistik ve oyun analizi, 
 bireysel ve takım istatistiklerine ait görüntülere kolay 

ulaşım, 
 takımınızın ve rakiplerinizin eğilimlerini takip etmek için 

bir çok araç, 

TRACK PLAYER ACTIONS 

 track individual player and team actions, 
 analyze games to improve your team’s performance, 
 link actions and statistics to game footage to cut-up 

video automatically, 
 organize and review video clips with the push of a 

buton, 

ANALĠZ YAPMAK DAHA ÖNCE HĠÇ SEVĠLMEZDĠ 

 hızlı bir şekilde her türlü istatistiğe erişim, 
 gelişmiş raporlama özellikleri ile müsabakaya bakış, 
 ekibinizin eğilimlerini ve zayıf yönlerini belirlemek için 

analiz sonuçları, 
 rakibinizin eğilimlerini ve zayıf yönlerini belirlemek için 

analiz sonuçları, 
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OYUN ANALĠZĠNĠN DÖRT KOLAY YOLU 

 saha üzerinde aksiyonun yerini seçin, 
 klavye kısayol tuşlarını kullanın, 
 gerçek zamanlı analiz yapın, 
 mikrofona konuşarak analiz yapın, 

OYUNCULARLA ĠLETĠġĠMĠN EN ĠYĠ YOLU 

 oyuncuların performan ve davranışlarını geliştirmek için 
video üzerinden işaretleyin, 

 başarılı ve başarısız ataklara ait video klipleri 
düzenleyin, 

 analiz sonuçlarına ait görüntüleri CD, DVD, DIVX, WMV 
yadar iPod bir çok popüler formatta kaydedin, 

 eğilimleri gelişmiş raporlama ile ortaya koyun. 
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Analiz BaĢlamak Ġçin Yol Haritası 
 
Bütün branşlar için geçerli olmak üzere aşağıdaki sorunların 
cevabı verildiğinde analize başlanmış olacaktır. Sırayla 
sorulara ait cevapları program üzerinde vermeye 
çalışmalısınız. 
 

1. Analiz yapacağınız sezon var mı? (Bakınız Sezon) 

2. Sezonun altında müsabakaya ait kulüpler var mı? 

(Bakınız Takım) 

3. Kulüplerin altında oyuncu kartları var mı? (Bakınız 

Oyuncu Kartları) 

4. Sezonun altında analizi yapılacak müsabaka açıldı mı? 

(Bakınız Müsabaka) 

5. Açılan müsabakanın oyuncu kadroları girildi mi? 

(Bakınız Oyuncu Ekle Çıkar) 

6. Müsabakaya ait videolar bilgisayara kopyalandı mı? 

7. Videolar video kataloğuna işlendi mi? (Bakınız Video 

Kataloğu) 

8. Hareket listesini kontrol ettiniz mi? (Bakınız Hareketler) 

 
Yukarıdaki 8 sorunun cevabı verilmiş ise o müsabakanın 
altında videolu analiz kaydı satırı ile artık analize 
başlayabilirsiniz. 
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1. eAnaliz’ e BAġLARKEN 

1.1. Sezon 

 
Sezon ağaç yapının en üst elemanıdır. O sezona ait kulüpler, 
analizler, sonuçlar vs hepsi sezon sekmesinin altında yer alır. 
 
Sezon Eklemek 
 

 
 

Sezon eklemek için: 
1. Menüden Insert > Season seçilirse yukarıdaki sezon 

ekleme penceresi ile karşılaşılır. 
2. İstenilen sezon seçimi yapılır. 
3. OK butonu tıklanır. 

Yeni sezon eAnalyze  penceresinin solunda bulunan ağaç 
yapıda görülür. Önündeki küçük + ya tıklandığında alt başlıklar 
görülebilir. (Müsabakalar, Kulüpler) 
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1.2. Takım 

 
Sezonun altına istenildiği kadar takım eklenebilir. Bir takımı bir 
sezon için bir kez eklemek yeterli olacaktır.  
 
Takım eklemek 
  

 
 
Takım eklemek için: 
  

1. Menüden Insert > Team seçimi yapılırsa yukarıdaki 
ekran ile karşılaşılır,  

2. İlgili sezon seçilir,.  
3. Daha sonra eklenmek istenen kulüp adı yazılır,  
4. OK. butonu tıklanır. 

 
Soldaki ağaç menüde yeni eklenen takımın önündeki + ya 
tıklandığında altındaki alt başlıklar “Player Cards” ve “Coach 
Cards”.olarak görülür. 
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1.3. Müsabaka 

 
Sezonun altında daha önce eklenmiş takımlardan istenilen 2 
tanesi seçilerek müsabaka eklenir. Müsabakaya ait takımların 
daha önce açılmış olması gerektiği unutulmamalıdır. 
 
Müsabaka eklemek 
  

 
 
Müsabaka eklemek için: 
  

5. Menüden Insert > Match seçimi yapılırsa yukarıdaki 
ekran ile karşılaşılır,  

6. İlgili sezon seçilir,.  
7. Evsahibi takım seçilir, 
8. Daha sonra Misafir takım seçilir, 
9. OK. butonu tıklanır. 

 



 16 

 
Soldaki ağaç menüde yeni eklenen müsabakanın önündeki + 
ya tıklandığında altındaki alt başlıklar görülebilir. Burada 
müsabakanın farklı şekillerde analizlerinin yapılabildiği alt 
yordamlar ile analiz sonuçlarının irdelendiği çok sayıda alt 
yordam bulunmaktadır.  
 
Müsabaka eklendikten sonra müsabaka bilgileri ekranından 
kadroların girilmesi işlemini gerçekleştirebilirsiniz.  
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1.4. Klasör Eklemek 

 
Sezonun altında açılan karşılaşmalar listesi belli bir süre sonra 
giderek çoğalmakta ve aranılan karşılaşmanın bulunması 
zaman alabilmektedir. Bu sebeple karşılaşmaların altında grup 
açmak daha mantıklı olacaktır. Örneğin “Avrupa Kupası”, 
“Hazırlık Maçları”, “Lig Maçları” gibi gruplar açıp bunların 
içerisine ilgili maçları açmak daha düzenli bir görüntü 
oluşturacaktır. 
 

 
 
Klasör  eklemek 
 

 Butonu ile istenilen sezonun altına istenilen klasör 
eklenebilir. 
 

 Butonu ile de daha önce oluşturulan klasörün adı 
değiştirilebilir yada silinebilir. Öncelikle ilgili klasörü seçtikten 
sonra bu buton tıklanarak bu işlemler yapılabilir. Klasörün 
silinebilmesi için altınma maç açılmamış olması gereklidir. 
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1.5. Oyuncu Kartı 
 
Takımın altında istenildiği kadar oyuncu kartı açılabilir. Burada 
oyuncu adı ve forma numarası anahtar 2 alandır ve girilmesi 
zorunludur. Diğer bilgi alanları ise isteğe bağlıdır ancak, çok 
önemli referans bilgileri taşıyabildiğini görebilirsiniz. 
 

 
 
Takım için oyuncu kartı eklemek 

1. Menüden Insert > Player Card seçimi yapıldığında  
yukarıdaki ekran ile karşılaşılır.  

2. Sezon seçimi yapılır.  
3. Kulüp seçimi yapılır..  
4. Oyuncu adı yazılaray ONAY butonu tıklandığında takım 

için yeni bir oyuncu kartı açılır.  
 
Ağaç menüden ilgili oyuncu üzerine tıklayarak oyuncu kartının 
açılmasını sağlayabilirsiniz. 
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Oyuncu kartında doldurulabilir birçok bilgi alanı olmasına 
rağmen en önemli iki bilgi alanı oyuncu adı ve forma 
numarasıdır. Bu iki alan mutlaka doldurulmalıdır. Diğer 
bilgilerin doldurulması isteğe bağlıdır. Kulübün bütün 
oyuncuları için kart açmak mümkündür. Kulüp için bir oyuncu 

kartı açıldıktan sonra yukarıdaki ekranda  resimli butona 
tıklayarak kısa yoldan yeni bir oyuncu kartı açmak çok daha 
kolaydır. 
 

 Resimli buton ile oyuncu kartları ile ilgili detaylı raporların 
alınabileceği raporlama bölümü çalışıtırılabilir. 
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1.6. Antrenör Kartı 
 
Oyuncu kartlarında olduğu gibi benzer şekilde takımın altında 
istenildiği kadar antrenör kartı da açılabilir.  
 

 
 
Takım için antrenör kartı eklemek 

1. Menüden Insert > Coach Card seçimi yapıldığında  
yukarıdaki ekran ile karşılaşılır.  

2. Sezon seçimi yapılır.  
3. Kulüp seçimi yapılır..  
4. Antrenör adı yazılaray ONAY butonu tıklandığında 

takım için yeni bir antrenör kartı açılır.  
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1.7. Hareketler 

 

 
 
 
Video üzerinden 2 farklı şekilde analiz yapmak mümkündür. 

 Müsabaka görüntüsü üzerinden video parçalarının 
çıkartılması (Video Edit) 

 Müsabaka görüntüsü üzerinde bireysel aksiyonların 
işaretlenmesi (Bireysel İstatistikler) 

 
Dolayısı ile bu iki farklı yöntem için isimlendirmelerde farklı 
olacaktır. 
 

Video Analiz 

Klip Analiz Bireysel Analiz 
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1.7.1.  Hareketler (Klip Analiz) 

 
Klip analiz Mantığı : 
Video üzerinden istenilen uzunlukta belirli yerlerin 
işaretlenmesi ve bu bölümlerin bir aksiyon ve takım adı ile 
ilişkilendirilmesinden ibarettir. Burada video üzerinde başlangıç 
ve bitiş yeri kullanıcı tarafından belirlenir. 
Böylece çok kolay bir şekilde müsabaka görüntüsü üzerinden 
özet görüntüler çıkartılır. 
 

 
 
Bu işaretlenen video parçalarının isimlendirilmesi ihtiyacı 
olduğu açıktır. Bu isimlendirmeleri; 
 

 
toolbar da işaretli ikon ile açılan pencerede yapabilirsiniz. 
 

 
 
Add Yeni bir klip adı satırı ekler. 
 
Delete İstenilen satırı seçtikten sonra bu buton yardımıyla 
silebilirsiniz. 
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Sırası Kolonundaki rakamı değiştirerek listeyi kendi içinde 
sıralayabilirsiniz. 
 
Hotkey herhangi bir harf ile kısayol atayabilirsiniz. Bu klavye 
kullanarak hızlı analiz yapma konusunda çok önemli fayda 
sağlayacaktır. 
 
Görünür Buraya çek atılanlar analiz ekranında listede 
görünecektir. Listede geçici olarak görünmesini istemediğiniz 
klip isimleri için çeki kaldırabilirsiniz. Çek tekrar atıldığında 
tekrar görünecektir. 
 
Before After Kısayollar kullanırak analiz yapıldığında eğer 
before after kolonları dolu ise, kısayola basıldığında basılma 
anından Before de bulunan sn kadar öncesinden After da 
bulunan sn sonrasına kadar klip otomatik olarak kesilir. Buda 
analizde oldukça hızlı bir çözüm demektir. Tek harf basımında 
bir klip kesilmiş olur. Eğer Before ve After değerlerinden ikisi 
birden sıfır ise bu dikkate alınmaz. Harfe ilk basıldığında o 
klibin kesimi başlatılır. Tekrar basıldığında basılma anına 
kadar klip kesilmiş olur. Diğerinden farkı başlama ve bitişin 
kullanıcı insiyatifinde olmasıdır. 
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1.7.2.  Hareketler (Bireysel Analiz) 

 
Bireysel Analiz Mantığı : 
Video üzerinde bireysel aksiyonun olduğu anda, o aksiyon 
karesinin bir oyuncu ve bir aksiyon adı ile ilişkilendirilmesinden 
ibarettir. Burada video üzerinde başlangıç ve bitiş yeri söz 
konusu değildir. Bu sebeple video üzerinde bu aksiyon 
yerinden kaç sn öncesinden kaç sn sonrasına kadar 
oynatılacağı bilgisi ayrıca belirtilir. 
 

 
 
Bu işaretlenen video parçalarının isimlendirilmesi ihtiyacı 
olduğu açıktır. Bu isimlendirmeleri; 
 

 
toolbar da işaretli ikon ile açılan pencerede yapabilirsiniz. 
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Add Yeni bir klip adı satırı ekler. 
 
Delete İstenilen satırı seçtikten sonra bu buton yardımıyla 
silebilirsiniz. 
 
Sırası Kolonundaki rakamı değiştirerek listeyi kendi içinde 
sıralayabilirsiniz. 
 
Görünür Buraya çek atılanlar analiz ekranında listede 
görünecektir. Listede geçici olarak görünmesini istemediğiniz 
klip isimleri için çeki kaldırabilirsiniz. Çek tekrar atıldığında 
tekrar görünecektir. 
 
Ġyi/Kötü Girilen bireysel aksiyonun olumlu yada olumsuz 
olmasının ayrımını sağlar. Çek atılan hareket isimleri olumlu 
olarak kabul edilir. Buradan bir oyuncunun müsabaka 
içerisinde toplam kaç tane olumlu kaç tane olumsuz aksiyon 
yaptığı gibi istatistikler hesaplanır. 
 
Efficiency Burada istenilen hareket isimlerine + yada – puan 
verilebilir. Sonuçta oyuncunun müsabaka boyunca yaptığı 
hareket adetleri bu katsayılarla çarpılarak efektiflik değeri 
bulunur. Puan verilmeyen hareketler değerlendirmeye dahil 
edilmez. 
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2. MÜSABAKA BĠLGĠLERĠ 

2.1. Kadroların Girilmesi 
 
Yeni bir müsabaka eklendiğinde kadrolar doğal olarak boştur. 
Takımların oyuncu kartlarından seçim yapılarak söz konusu 
müsabakada yer alan oyuncuların girilmesi gereklidir. Eğer 
takımın altında oyuncu kartları açılmamış ise burada oyuncu 
eklemekten söz etmek mümkün değildir.  
 

 
 
Müsabaka Bilgilerinde Oyuncu Eklemek 
 
Açılan müsabakanın altında “Müsabaka Bilgileri” isimli satır 
tıklandığında yukarıdaki ekran ile karşılaşılır. Bu ekranda 
evsahibi ve misafir takımım kadroları görülebilir. Takımların bu 
müsabaka için oyuncu kadrolarını belirlemek üzere, listenin 
hemen üzerinde bulunan “Add Player” başlığına tıklamak 
yeterli olacaktır. 
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Soldaki listede takıma ait oyuncu kartları listelenir. Bu liste 
üzerinde istenilen oyuncu satırına çift tıklanarak sağdaki 
listeye alınabilir. Sağda oluşturulan liste takımın bu 
müsabakadaki oynayan oyuncu listesi olacaktır. Sağdaki 
listede oyuncuların önündeki buton sayesinde sıralamayı 
değiştirmek mümkündür. 
 
Müsabakada oynayan oyuncuların listesinin bu şekilde 
oluşturulması bireysel istatistikler için gereklidir.  
 
Klasörü DeğiĢtirmek 
 
1.4. de anlatıldığı şekilde açılan klasörler içerisinde daha 
düzenli bir ağaç menü oluşturulması mümkündür. Açılan 
müsabakanın istenirse “Folder” bölümünden bu klasörlerden 
istenilen seçilerek müsabakanın ağaç menüdeki yeri 
değiştirilebilir. 
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2.2. Sahaya Yerleşim (Lineups) 

 
Müsabaka Bilgileri ekranında sol tarafta bulunan interaktif saha 
üzerinde takımların yerleşim planları tasarlanabilir.  
 

 
 
Oyuncu iliĢkilendirilmesi 
 
Saha üzerindeki oyuncu modeli seçildikten sonra istenen 
oyuncu adına tıklanırsa seçili model ile oyuncu ismi 
ilişkilendirilebilir. Bu sayede bu müsabakaya hangi düzende ve 
hangi oyuncularla başlandığı temsili olarak gösterilebilir. Yine 
oyuncu modellerinin saha üzerindeki yerleri sürükle bırak ile 
değiştirilebilir.  
 
Bu yerleşim planını “Save” butonu yardımı ile kaydetmek 
mümkündür. Yerleşim planlarından 10 değişik sahne 
tasarlamak ve bunları kayıt altına almak mümkündür. 
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Saha üzerinde çizgi oluĢturmak 
 

 seçimi ile çizgi kalınlığı seçilebilir. 
 seçimi ile de çizgi rengi belirlenir.  

 
Daha sonra saha üzerinde Mouse yardımı ile istenilen serbest 
çizgiler oluşturulabilir. 
 

 
 
Size 

 
(+) ve (-) butonları kullanılarak forma simgelerinin büyüklüğü 
ayarlanabilir. Reset butonu ile orijinal boyuta tekrar dönülebilir. 
 
Label 

 
Butonu ile forma simgeleri altında oyuncunun adının 
görüntülenmesi sağlanır. 
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Align 

 
Sahadaki forma simgelerinin saha modelinin sol ve sağ 
tarafına alınması için bu butonlar kullanılır. 
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2.3. Müsabaka Genel Bilgileri 
 
Müsabaka hakkındaki genel bilgiler saha modelinin hemen 
altında bulunmaktadır. 
 

Name 
Default olarak seçilen evsahibi ve misafir takımın adları 
olarak belirlenir. 
 
Date 
Müsabaka tarihinin Ay / Gün / Yıl olarak girileceği alandır. 
 
Location 
Müsabakanın oynandığı stat yada yer bilgisinin girileceği 
alandır. 
 
Score 
Müsabaka için skorun girileceği alandır. 
 
Length 
Müsabakanın dakika cinsinden ne kadar sürdüğü 
bilgisinin girileceği alandır. 
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3. VĠDEO ÜZERĠNDEN ANALĠZ YAPMAK 

3.1. Video Kütüphanesi 
 
Analizi yapılacak karşılaşmaya ait videoların bilgisayar hard 
diskine kopyalanması gerekmektedir. Bunun için USB hard 
disklerde çok uygun depolama araçlarıdır. Dvd sürücüden 
direk analiz yapmak hiç uygun değildir. Hem dvd yavaştır hem 
de bir çok müsabakanın analizi birleştirilip görüntüye ulaşılmak 
istendiğinde tek dvd yetersiz kalacaktır. 
 
Bilgisayara kopyalanan müsabaka videolarının eAnalyze 
tarafından algılanabilmesi için video kataloğuna işlenmesi 
gerekmektedir. Video kataloğunu menüden Tools > Video 
Library yoluyla açabilirsiniz. 
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Açıklama 
Eklenen videoyu anımsatacak bir açıklamanın yazılacağı 
alandır. Müsabakanın adını kullanmak çok faydalı 
olacaktır. (Beşiktaş – Fenerbahçe 1) gibi. 
 
Video Dosya Yolu 
Eklenen videonun hard diskte nerede bulunduğunu 
gösterir. 
Önceliği 
Eklenen videoların sırasının değiştirilmesi buradaki 
rakamların istenilen şekilde değiştirilmesi ile yapılır. 
 
Gizle 
Videolar eklendikçe bu listenin çok uzayacağı açıktır. 
Analizi yapılan ve artık eskide kalan müsabakalara ait 
satırların analiz yapma ekranında görünmemesi ve 
listenin daha kısa görünmesi için burada istenmeyen 
satırlara çek atmak yeterli olacaktır. Eğer tekrar ilgili 
müsabaka ile ilgili bir işlem yapılacaksa bu çek tekrar 
kaldırılmalıdır. 
 

 
Video Ekle 
 
Sadece bir video eklenecek ise “Video Ekle” butonu tıklanır. 
Açılan pencereden ilgili video bulunup seçildiğinde video 
kataloğuna eklenilmiş olur. Video eklendikten hemen sonra 
açıklama bölümünü doldurmayı unutmayınız. Analiz yapma 
ekranında bu açıklamalar görüneceğini unutmayınız. 
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eAnalyze tarafından uygun kodekler yüklendiğinde 
desteklenen formatlardan bazılarının açıklaması aşağıdaki 
gibidir. 
 

 File 
Extension 

 Format 

 ASF 
 Advanced Systems Format, developed by 
Microsoft for streaming 

 AVI 
 Audio Video Interleave, developed by Microsoft 
for Windows 

 FLV 
 Flash Video, developed for the Adobe Flash 
Player 

 M4V 
 iTunes Video File, developed by Apple based 
on MPEG-4 

 MOV  QuickTime video, developed by Apple 

 MPEG-1 
 The Moving Pictures Experts Group video 
format, standard 1 

 MPEG-2 
 The Moving Pictures Experts Group video 
format, standard 2 

 MP4 
 (MPEG-4) 

 The Moving Pictures Experts Group video 
format, standard 4 

 RM  Real Meadia, developed by RealNetworks 

 VOB 
 Video Object, the standard format for DVD 
video media 

 WMV 
 Windows Media Video, a compressed file 
format developed by Microsoft 
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3.1.1. Video Kütüphanesine DVD Eklemek 

 
Bilindiği üzere DVD ler en fazla kodek problemi yaratan 
görüntü tiplerinin başında gelir. Bu sorunu aşmak için video 
kütüphanesine dvdleri birkaç dakikada (bilgisayarın işlemci 
gücüne bağlı olarak 4 - 10 dakikada) standart .mpg. formatına 
çevirecek bir modül eklenmiştir. Bu sayede görüntü kalite 
kaybı da olmaksızın dvd tek bir mpg dosyaya dönüştürülüp 
video kataloğuna otomatik olarak  eklenmektedir 
 
Bunu yapmak için dvd dosyalarını içeren “VIDEO_TS” 
klasörünü video kataloğu listesi üzerine sürükleyip bırakmak 
yeterli olacaktır. 
 

 
 
Bundan sonra dvd yi mpg e çevirecek olan sihirbaz devreye 
girer.  
 

 
 
Birinci adımda DVD klasörü içinde bulunan VOB görüntü 
dosyaları listelenir. İstenmeyen satırlardaki Çekler kaldırılarak 
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o satırdaki video görüntüleri çevirme işleminin dışında 
tutulabilir. 
 

“Proje Adı” na müsabakanın adını yazarak devam edebilirsiniz. 
 

 
 

2. ekranda seçilebilecek 2 metod vardır. 1. Metod dosyaların 
mpg e dönüştürülüp birleştirilmesi işini yapar. (Tavsiye edilen 
yöntemdir.) 2. Metod ise görüntü dosyalarını olduğu gibi 
kataloğa eklenmesidir ve herhangi bir işleme tabii tutulmaz. 1. 
Metod seçildikten sonra son ekrana geçilirse : 
 

 
 

Oluşacak dosya adı ve kayıt yeri  butonu yardımıyla 
belirlenerek “Final” butonu tıklandığında DVD dönüştürme 
işlemi başlatılır. Dönüştürme işlemi bitirildikten sonra artık 
“VIDEO_TS” klasörüne ihtiyaç kalmaz. Analiz için yeni oluşan 
.mpg dosya kullanılır. 
 

NOT : OluĢacak dosya adını belirlerken Türkçe karakter, 
boĢluk yada özel karakterler kullanmayınız. 



 37 

3.1.2. Video Kütüphanesine Klasör Eklemek 

 
Özellikle salon sporlarında hard diskli kamera ile çekim 
yapıldığında her pause – record yapıldığında yeni bir mpg 
dosya oluşur. Örneğin bir basketbol müsabakası için 80-100 
adet video parçası oluştuğu çok sık rastlanan bir şeydir. 
 
Bu kadar çok video parçacığının video kataloğuna eklenmesi 
rasyonel bir çözüm olmaktan uzaktır. Bu video parçalarını 
birleştirmek için video kataloğunda liste üzerine içinde video 
parçacıkları bulunan klasörü sürükleyip bırakmak yeterli 
olacaktır. 
 

 
 
Bundan sonra klasörün içerisinde bulunan tüm mpg dosyalar 
otomatik olarak taranır ve listelenir.  
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Bu ekranda özellikle faul atışları skorbord çekimleri gibi çok 
kısa olan ve analizde kullanılmayan parçacıklar “Al” 
kolonundaki çek kaldırılarak devre dışı bırakılabilir. Ancak çok 
da gerekli değildir. “Proje Adı” na müsabakanın adını girerek 
devam edildiğinde aşağıdaki ekranla karşılaşılır. 
 
1. Metod dosyaların mpg e dönüştürülüp birleştirilmesi işini 
yapar. (Tavsiye edilen yöntemdir.) 2. Metod ise görüntü 
dosyalarını olduğu gibi kataloğa ekler, herhangi bir işleme tabii 
tutmaz. Birleştirme işlemi için 1. Metod seçilerek “İlerle” butonu 
tıklanır. 
 

 
 

Oluşacak dosya adı ve kayıt yeri  butonu yardımıyla 
belirlenerek “Final” butonu tıklandığında mpg birleştirme işlemi 
başlatılır. Dönüştürme işlemi bitirildikten sonra artık analiz için 
oluşan tek bir .mpg dosya kullanılır. Video parçacıklarının 
bulunduğu klasöre de ihtiyaç kalmaz. 
 
NOT : OluĢacak dosya adını belirlerken Türkçe karakter, 
boĢluk yada özel karakterler kullanmayınız. 
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3.2. Video Üzerinden Analiz 

 

3.2.1. Video Üzerinden Analiz Üzerine 

 
Ağaç menüde seçtiğiniz müsabakanın altında bulunan 
“Videolu Analiz Kaydı”na tıklandığında 4 pencereden oluşan 
analiz ekranı açılır. Bunlar Saha modeli, Video ekranı, Analiz 
kaydı ekranı ve Oyuncular ve hareketler ekranlarıdır. 
 

 
 
Analiz başlayabilmek için öncelikle videonun bilgisayara 
kopyalanmış ve video kataloğuna girilmiş olması gereklidir. 
Ayrıca bireysel istatistikler çıkarılacaksa oyuncu kartları ve bu 
müsabaka için kadro girilmiş olması da gereklidir. 
 
VĠDEO 
Videolu analiz kaydının en önemli penceresidir. Hem 
müsabakaya ait videoların kontrolünü sağlar. Hem de klip 
analiz işlemlerini yürütür. 
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SAHA 
Video oynat durdur ile ilgili aksiyon sahnesine ulaşıldığında 
bireysel istatistikler için olayın yerini bu temsili saha üzerinde 
işaretlemek sureti ile analiz yapılır.  
 
OYUNCULAR ve HAREKETLER 
Bu ekranda da bireysel istatistik için aksiyon listesi ile bu 
müsabaka için girilmiş kadrolar gözükür. Buradan yapılan 
aksiyon ile kimin tarafından yapıldığı seçimi kolayca yapılabilir. 
 
ANALĠZ KAYDI 
Yapılan bireysel istatistik kayıtlarının gösterildiği penceredir. 
Son yapılan kayıt bu listede en üstte gösterilir. Böylece takip 
kolaylaşır. 
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3.2.2. Video  

 
Videolu analiz kaydı yapılırken video üzerinde hakimiyeti en 
üst düzeye taşıyan kontrollerle desteklenmiş ekrandır. Tabiî ki 
müsabaka için gerekli videoların bilgisayara kopyalanmış 
olması ve video kataloğuna işlenmiş olması gerektiği 
unutulmamalıdır.  
 

 
 
Analize ilk başlanacağı zaman “Video Seçimi” listesinden 
video seçilir. Video seçimi yapılıp bireysel istatistikler 
yapılmaya başlandığında videolu analiz kaydı pencereleri 
kapatılıp tekrar açıldığında en son analiz yapılan video 
otomatik olarak açılır ve videoda ilgili yere gidilir. Yani analize 
ara verilip program kapatıldığında ve tekrar analiz yapmak 
üzere açıldığında video olması gereken yere otomatik olarak 
gelir. Buda büyük kolaylık sağlar. 
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Milisaniye de bulunan 500 değeri ileri geri butonlarına 
tıklandığında yarım saniye ileri yada geri gitmeyi sağlar. Bu 
değer örneğin 2000 yapıldığında ileri geri gitmeler 2 sn 
olacaktır. Bu sayede ileri geri sıçramaları kullanıcı istediği 
uzunlukta ayarlayabilir. 
 
Fotoğraf 

 Butonu ile video üzerinde o anki sahnenin fotoğrafı .jpg. 
formatında alınabilir. 
 

 Durdurma ve oynatma için 2 işlevli butondur. 
 

  İleri geri alma butonlarıdır. Milisaniye de bulunan 
değere göre sıçrama yaparlar. 
 

 Hız butonudur. 1 değeri videonun normal hızla 
oynamasını sağlar.  Yarım hızdır.  ise çift hızla 
oynamasını sağlar. Buda analiz yaparken bazı detayları 
görmek için ağır çekim yada istenmeyen bölümleri hızlı çekim 
oynatarak analizde hakimiyeti ve hızı artırır. 
 

  Analiz yaparken video sesi istenmiyorsa geçici 
olarak kapatmak ya da açmak mümkündür. Bu sadece 
seyrederken istenirse sessiz seyredilmesini sağlar. Yapılan 
analizlerde ses olacaktır. 
 

 
Zaman Sürgüsü : Video toplam zamanını ve şu anda nerde 
olduğunu gösterir. Bu sürgü kullanıalr sürükle bırak yöntemi ile 
videonun herhangi bir anına hızlı gitmek mümkündür. 
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Klip Kesmek 
Video kontrol ekranının önemli bir işlevi de videonun 
oynatılmasından başka istenen bölümlerin kesilerek klip analiz 
yapabilmesidir. 
 

Video izlenirken  ile klibin başladığı yer işaretlenir. Bir süre 
sonra tekrar bu butona tıklanırsa en son basılan yer başlama 
noktası olarak kabul edilir ve önceki başlama noktası unutulur.  
 
NOT : Analizciler her set baĢlangıcında bu buton ile 
başlangıç noktasını belirler ve setin sonuna geldiklerinde eğer 
almaya değer bulmazlar ise yeni set başlangıcında tekrar bu 
butona basarak yeni başlangıç noktasını belirlemiş olurlar. Bu 
sayede oldukça zaman kazanmaları ve video üzerinde geri ileri 
hareketleri en aza indirdikleri uygulayıcılar tarafından 
bildirilmiştir. 
 

 resimli buton ile başlangıç noktası belirlenmiş klibin 
tıklama anına kadar olan bölüm klip listesine alınır. Listenin 
hemen altından bu klip için ilgili takım ve klip adı seçimi yapılır. 
 
Listenin altındaki “İlgili Oyuncular” butonu ile de bu klip ile 
ilişkili oyuncuların seçimini yapılabildiği ekran açılabilir. (isteğe 
bağlı) 
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3.2.3. Saha 

 
Bireysel istatistiklerin kaydedilmesi, videodan aksiyonun 
olduğu noktada sahada temsili olarak olay yerine tıklanması ile 
gerçekleşir. Saha üzerine tıklandığında bireysel istatistiklere 

bir kayıt eklenmiĢ olur. Burada 
dikkat edilmesi gereken sahanın 
üstünde ortada bulunan “ok” 
simgesinin gösterdiği yönün 
evsahibi takımın hücum yönünü 
göstermesi gerektiğidir.   
Müsabaka başlarken ve ikinci devre 
buna dikkat etmek yeterli olacaktır. 

 
Saha üzerine tıklandığında tıklanan 
yerde kadroların olduğu bir pencere 
belirir ve buradan aksiyonu yapan 
oyuncu satırına tıklanarak kolayca 
aksiyonu yapan oyuncu seçilir. 
 
 
 
 
 
 
 

 
Oyuncu seçimi yapıldığında oyuncu 
listesi penceresi otomatik olarak kapanır 
ve hareketlerin yer aldığı bir başka 
pencere belirir. Buradan da yapılan 
aksiyon satırına tıklanarak aksiyon adı 
da belirlenmiş olur. Aksiyon seçimi 
yapıldığında aksiyon listesini gösteren 
pencerede kendiliğinden kaybolacaktır. 
Bu sayede 3 tıklama ile yer, oyuncu ve 
aksiyon seçimi tamamlanmış olur. 
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3.2.4. Oyuncular ve Hareketler 

 
Oyuncu ve hareketler listesinin sürekli gösterildiği penceredir. 
Bireysel istatistiklerin herhangi bir satırında oyuncu yada 
hareket yanlış seçilmiş ise bu pencereden ilgili oyuncu yada 
hareket satırına tıklanarak bireysel istatistiklerde düzeltme 
iĢlemi de kolayca yapılır. Buda oldukça pratik bir düzeltme 
işlemi sağlayarak analizde geri dönüşleri kolaylaştırır ve analiz 
bitme süresine olumlu katkı sağlar. 
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3.2.5. Analiz Kaydı 
 
Saha üzerine tıklandıkça bireysel istatistik satırları oluşmaya 
başlar. Bu listede aksiyonu yapan oyuncunun adı, yaptığı 
aksiyon gibi bir çok bilgi yer alır.. 
 

 
 
Oyuncu 
Aksiyonu yapan oyuncu adını gösterir. Eğer yanlış bir oyuncu 
seçilmiş ise yada boş ise 3.3.4 deki listeden istenilen oyuncu 
adına tıklanarak değişmesi sağlanabilir. 
 
Hareket 
Yapılan aksiyon adıdır. Yine yanlış girilmiş yada boş ise 3.3.4 
deki listeden istenilen aksiyona tıklanarak değişmesi 
sağlanabilir. 
 
Before 
Tıklama anından kaç saniye öncesinden itibaren 
oynatılacağını belirten rakam vardır. Program herhangi bir 
değer yok ise 5 olarak belirler, kullanıcı isterse bunu 
değiştirebilir. 
 
After 
Tıklama anından kaç saniye sonrasına kadar oynatılacağını 
belirten rakam vardır. Program herhangi bir değer yok ise 4 
olarak belirler, kullanıcı isterse bunu değiştirebilir. 
 
Before ve After değerleri ile her satırın oynatılma zamanları 
bağımsız olarak belirlenir. Bu sayede toplantı esnasında fazla 
görüntü kümeleri gösterilmesinin önüne geçilir. Toplantı süresi 
ve kalitesine katkı sağlar. 
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Kayıt Silmek 
Bireysel kayıtlardan herhangi bir satırı silmek için o satırın 
önündeki küçük kutucuğa Mouse ile tıklayarak siyaha 
boyamak yeterlidir. 
 

 
 
Zamanı Ayarlamak 
İstatistik kayıtlarına müsabakanın oynama dakika ve saniye 
bilgileri videodan otomatik olarak alınır. Ancak çoğu zaman ilk 
yarı ayrı ikinci yarı ayrı bir video parçası olarak kaydedildiği 
için analize devam etmek için ikinci video seçildiğinde zaman 
tekrar 1. Dakika 1. Saniye gibi sıfırlar. Halbuki müsabakanın 
45. Dakikası oynanmaktadır. Dakikanın 45 in üzerine devam 
etmesini sağlamak için “Time” alanına eklenecek dakika girilir. 
Bu sayede yeni kayırlara +45 gibi bir değer eklenerek analiz 
dakikaları doğru hale getirilir. Bu şekilde zaman düzeltmesi 
yapıldığında sonuç sorgulamalarında 80. Dakika ile 90. Dakika 
arasında olanlar gibi bir çok sorgu doğru çalışacaktır. 
 

 
 
Hücum Yönünü DeğiĢtirmek 
Sahanın üzerindeki hücum yönü işaretinin ev sahibi takımın 
hücum yönünü göstermesi gerektiği anlatılmıştık. Hücum yönü 
yanlış girilen kayıtlar varsa bunların hücum yönünü düzeltmek 
için listede oyuncu adına çift tıklamak yeterli olacaktır. 
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3.3. Video Üzerinden Sesli Analiz 

 

3.3.1. Video Üzerinden Sesli Analiz Üzerine 

 
Bireysel istatistiklerin video üzerinden oynat durdur işaretle 
mantığı ile çıkartılması oldukça zaman alan ve emek isteyen 
bir uğraştır. Bütün oyuncular ve bütün aksiyonlara bakıldığında 
bir futbol müsabakasının analizi yaklaşık olarak 6 - 7 saat 
sürebilmektedir. 
 
Sesli sistem bu analiz süresini kısaltmak üzere tasarlanmıştır. 
Mouse ile tıklamak yerine özel bir mikrofon aracılığı ile bölge 
adı, oyuncu adı ve aksiyon adı okunmaktadır. Mikrofona 
söylenen sözcükler program tarafından algılanarak Mouse ile 
tıklamaya gerek kalmadan yeni kayıtlar eklenmekte ve böylece 
analiz süresi hatırı sayılır oranda azalmaktadır. Bu yöntemle 
analiz süresi 2 - 2.5 saate kadar düşmektedir. 
 
Sesli sistemin avantajı analiz süresinde ciddi zaman 
tasarrufudur. Ancak analiz sonuçlarının değerlendirilmesi, 
raporların alınması gibi sonuç üretim ekranları ve belgeleri 
aynıdır. 
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3.3.2. Video Üzerinden Sesli Analiz Yapmak 

 
Daha önce analiz yapma yöntemi olarak mouse kontrolü ile 
videonun oynatılıp durdurulması, saha üzerinde aksiyon yerine 
tıklanması, daha sonra oyuncu ve aksiyon adına tıklanarak 
yapıldığı anlatılmıştı. Sesli sistemde ise saha 24 parçaya 
bölünmüş durumda olmak üzere mikrofona bölge adı + oyuncu 
adı + aksiyon adını söylemek yeterli olacaktır. Videoyu 
oynatmak için “oynat” durdurmak için “durdur” demek yeterlidir.  
 

 
 
Bölge adı söylendiğinde sahaya tıklanmış gibi yeni bireysel 
analiz satırı açılır. Oyuncu adı söylendiğinde ilgili oyuncu adı 
işlenir ve son olarak hareket adı söylediğinde aksiyon işlenmiş 
olur.  
 
Oyuncu adı yanlış söylenmiş ise düzeltmek için tekrar oyuncu 
adı söylenir. Aynı şekilde aksiyon adı tekrar söylenirse en son 
söylenen aksiyon adı işlenir. Böylece mouse yöntemindeki 
düzeltmeler sesli sistemde de uygulanabilir. 
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3.3.3. Ses Ayarları 
 
Menüde “Voice” başlığı altında bulunan “Voice Options” 
seçeneği ile ses tanıtımı ayarlarının yapıldığı ekranı açınız. 
 

 
 

 butonu ses tanıtma sistemini başlatır. İlk defa 
kullanıyorsanız Erkek (Men) ya da Kadın (Women) seçimini 
yapınız. “Delete” ile var olan kullanıcıyı siliniz ve arkasından 
“Add” ile yeni kullanıcı oluşturunuz. 
 

 butonu ile sisteme bağlı olan ses kartı ile birlikte 
mikrofon seçimi yapılır. Bu seçim çok önemlidir. E-analiz ile 
birlikte size verilen Platronics marka mikrofonu seçtiğiniz 
takdirde çok daha kaliteli ses tanıma imkânına sahip 
olursunuz. 
 
Adaptation :Ses adaptasyonu yapmak sizin için zorunlu 
olmamakla birlikte yapıldığında çok daha iyi performans alınır. 
Bunun için ilk olarak daha önce yapılmış adaptasyon varsa 

 butonu ile siliniz.  butonu ile de yeniden tanıtımı 
başlatınız. Yeniden tanıtım penceresi açılır. E-analiz, sesli 
komutların sizin tarafınızdan okunmasını ister. 
 
Aşağıda görünen ekran yardımı ile analiz yaparken 
kullanacağınız hareket listeniz ve diğer komutlar sesinize göre 
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ayarlanır. Bu tanıtım işlemini yapmak zorunlu olmamakla 
birlikte, yapıldığında yüksek doğruluk oranı daha üst düzeye 
çıkmaktadır. 
 

 
(XXVII) 
 
“1” numaralı alanda okumanız istenen metin bulunur. Metni 
baştan sona normal konuşma hızınızda duraksamadan 
mikrofona okuyunuz. Yavaş yavaş ya da tane tane okumak 
istenmeyen bir durumdur. Konuşma alışkanlığınız ve hızınız 
nasıl ise aynı şekilde okuyunuz. Okuma işlemi sona erdiğinde 
“2” numaralı alanda okuma başarı grafiğiniz gösterilir. Harflerin 
altındaki yeşil çizgiler okumanın başarılı yapıldığını gösterir. 
Kırmızı çizgi görüyorsanız o harf tam olarak sistem tarafından 
anlaşılmamış demektir. Okuma işlemini bir kez daha 
tekrarlayınız. Harf aralıkları çok açılmış ise yavaş tempoda 
okudunuz anlamına gelir. Tekrar okuyarak harf aralıklarını 
örnekteki  gibi düzgün aralıklı hale getirin. Hemen sağdaki 
okuma katsayısı -50 ile -60 aralığında bir değer ise çok başarılı 
bir okuma yapılmış demektir. Görünen metnin okunması 
bitirildikten sonra “3” numaralı buton ile bir sonraki metne 
geçebilirsiniz. İşleme devam ederek katalogdaki tüm metin 
bitiriniz. “Çıkış” butonu ile bu işlemi sonlandırınız. Tekrar ses 

ayarları ekranına dönüldüğünde  butonuna tıklayınız. 

 yapılan okuma işlemlerinin adaptasyon işlemlerini 
başlatır. Bu bölümde otomatik olarak açılan pencerelerdeki 
işlemlerin bitirilmesini bekleyiniz. İşlem tamamlandığında 
sistem sizin sesine göre ayarlanmış olur. 
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 Önemli bir butondur. Hareket listenize yeni bir satır 
eklediğinizde önce sesli sistemi başlatınız ve sonra build 
grammer butonu ile grameri yenileyiniz. Eklediğiniz yeni 
hareket isimleri bu sayede ses tanıma sistemine dâhil edilir. 
 


